
1 von 31 11.10.2006 21:35

Blender Dokumentation/ Druckversion/ Gus

Aus Wikibooks

< Blender Dokumentation

Die erste Animation in 30 plus 30 Minuten

Diese Seite bezieht sich auf
Blender v2.42

In diesem Kapitel wird Schritt für Schritt beschrieben, wie
Sie eine Animation des kleinen "Gingerbread Man" 
(Pfefferkuchenmannes) erstellen können. Alle
durchzuführenden Schritte werden vollständig
beschrieben, aber wir nehmen an, dass Sie das gesamte 
Kapitel "Die Blenderbedienung verstehen" gelesen haben, 
und die Konventionen (Tastenkürzel, Menüpunkte,
Mausaktionen) verstehen, die in diesem Buch benutzt 
werden.

Seien Sie nicht entäuscht, wenn Sie länger als 2x30
Minuten benötigen, die Zeiten gelten für einen erfahrenen
Nutzer. Im ersten Teil werden Sie das
Pfefferkuchenmännchen bauen und mit Material versehen.
Im zweiten Teil bekommt Gus ein Skelett und lernt laufen.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/c1205.html) 

Aufwärmphase

Diese Seite bezieht sich auf
Blender v2.42

Lassen Sie uns anfangen.

Gestartet wird Blender entweder über ein Doppelklick auf das Blender Icon oder über die Kommandozeile. Nach dem
Öffnen wird der Standardbildschirm angezeigt: Eine Kamera, ein Würfel und eine Lampe. Wenn der Würfel pink
umrandet ist, ist er ausgewählt. Löschen Sie den Würfel mit X und bestätigen Sie das Löschen mit Erase selected 
Object(s) in der Dialogbox.

Abbildung 1:  Gus läuft!
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Jetzt wählen Sie die Kamera mit RMT  (also mit einem Klick mit der rechten Maustaste) an und betätigen die
M -Taste. Eine kleine Toolbox (Abbildung 2) öffnet sich, der erste Button müsste ausgewählt sein. Klicken Sie mit
LMT  (also der linken Maustaste) das obere Kästchen ganz rechts in der Toolbox an und bestätigen mit OK. Die 
Kamera befindet sich nun in Ebene [Layer] 10.

Blender unterstützt 20 Ebenen um die Arbeit zu erleichtern. Welche Ebenen gerade sichtbar sind, kann auf der
rechten Seite der Fensterleiste überprüft werden (Abbildung 3). Die sichtbare Ebene kann mit LMT  ausgewählt
werden. Mehrere Ebenen können bei gehaltener SHIFT -Taste ausgewählt werden.

Abbildung 1:  Der Startbildschirm von Blender.

Abbildung 2:  Die Ebenenauswahl Abbildung 3:  Die sichtbaren Ebenen. 
Hier sind Ebene eins und zwei

ausgewählt und sichtbar.
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Links

Die englischsprachige Vorlage dieses Textes
(http://www.blender.org/modules/documentation/htmlI/c1205.html#quickstart_start) 

Das Grundgerüst bauen

Diese Seite bezieht sich auf
Blender v2.42

Schalten Sie in die ZX-Ansicht durch Betätigen von
NUM1.
Um einen Würfel einzufügen, betätigen Sie die
SPACE-Taste. Wählen Sie dann Menü Add, Untermenü
Mesh, Unter-Untermenü Cube. Ein Würfel erscheint.

Dieser neu hinzugefügte Würfel befindet sich im EditMode, ein 
Modus in dem die Eckpunkte [Vertices] des Würfels frei im
Raum plaziert werden können. Nach dem Einfügen sind alle
Vertices ausgewählt (ausgewählt = gelb, nicht ausgewählt =
pink).

Nennen wir das Pfefferkuchenmännchen "Gus". Unsere erste
Aufgabe ist der Körper von Gus, den wir jetzt aus dem Würfel im
Edit Mode erstellen. Dabei werden wir nur eine Seite tatsächlich
modellieren, die andere Seite wird Blender für uns automatisch
erzeugen.

Im unteren Fensterbereich sollten bereits die Editing Buttons zu sehen sein, überprüfen Sie, ob in der
Werkzeugleiste der richtige Button aktiviert ist (Abbildung 2). Ist das nicht der Fall, drücken Sie F9 oder 
klicken Sie den Button an.

Abbildung 1:  Würfel im Edit Mode

Abbildung 2:  Der Button für die Editing Buttons
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Klicken Sie einmal auf den Subdivide-Button im Mesh Tools
Panel (Abbildung 3).

Jede Seite des Würfels wurde jetzt mit einem weiteren Vertex unterteilt
(Abbildung 4).

Drücken Sie die A-Taste, um die Auswahl aufzuheben.

Bedenken Sie, dass Tastaturbefehle nur in aktiven Fenstern 
funktionieren. Ein Fenster ist aktiv, wenn sich der Mauszeiger darin 
befindet. Die Vertices werden nun pink dargestellt.

Im 3D-Fenster kann ein Objekt in verschiedenen 
Voransichtsmodi [Draw Types] dargestellt werden, z.B. als 
Drahtgitter [Wireframe] oder massiv [Solid]. In der 
Voreinstellung werden die Objekte massiv [Solid] dargestellt, 
der Voransichtsmodus [Draw Type] soll aber jetzt gewechselt 
werden.

Wir müssen im sogenannten "Drahtgittermodus" [Wireframe]
weiterarbeiten.

Klicken Sie dazu auf das Auswahlfeld für Viewport 
Shading im Fensterheader des 3D-Fensters, und wählen
Sie dort Wireframe aus (Auswahl des Wireframe 
Modus).

Abbildung 3:  Die Editing Buttons. Für das Bild wurden die Panels etwas anders angeordnet.

Abbildung 4:  Der unterteilte Würfel

Auswahl des Wireframe Modus
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Drücken Sie die B-Taste (Border Select). Am Mauszeiger sind graue Linien zu sehen. Bewegen Sie den
Mauszeiger über die linke Ecke des Würfels, halten Sie LMT  gedrückt und ziehen mit der Maus ein Rechteck
über alle Vertices links der Mittellinie. Lassen Sie die Maustaste los.

Diese Arbeitsschritte zum Auswählen der Vertices sind in den folgenden Bildern noch einmal dargestellt.

Border Select

Häufig sind bei einem Objekt Vertices hinter anderen Vertices versteckt, so wie in diesem Fall. Der
unterteilte Würfel hat 26 Vertices, von denen man nur 9 sehen kann, da die anderen hinter den vorderen

liegen.

Ein normaler RMT  wählt nur einen der Vertices aus, Border Select wählt alle aus (solange Sie sich im
Wireframe Modus befinden). Sie haben daher in diesem Fall 9 Vertices ausgewählt, obwohl Sie nur drei
gelbe Vertices sehen können.

Drücken Sie jetzt die X-Taste und wählen Sie Vertices, um 
die ausgewählten Vertices zu löschen.

Undo

Seit Version 2.3 besitzt Blender ein Mesh Undo.
Drücken von U im Edit Mode nimmt die letzte "Mesh 

bearbeiten"-Aktion zurück. Hält man U gedrückt, werden
alle Aktionen zurückgenommen (solange es der
Undo-Speicher erlaubt). Shift-U stellt die Änderungen
wieder her. Alt-U  öffnet eine Liste mit allen Änderungen,
die zurückgenommen werden können.

Mesh Undo funktioniert nur im Edit Mode, und auch nur für
das jeweils bearbeitete Mesh. Die Undo-Daten gehen nicht 
verloren, wenn Sie zwischendurch in den Object Mode
schalten, erst wenn Sie ein anderes Mesh bearbeiten.

Durch Esc brechen Sie eine noch nicht bestätigte Aktion ab und kehren zu dem vorherigen Zustand des
Meshes zurück.

Wenden Sie das eben Gelernte nochmals an.

Wählen Sie die beiden oberen rechten Vertices mit Border Select aus (Abbildung 7, links).
Drücken Sie zum Extrudieren die E-Taste und wählen Sie im Extrude Menü Region, um die Auswahl zu
verlängern.

Abbildung 5:  Border Select

Abbildung 6:  Löschen der Vertices im Edit Mode
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Dabei werden neue Eckpunkte und Flächen erschaffen, die Sie nun bewegen können. Extrudieren Sie eine Region -
so wie in diesem Fall - erscheint eine Linie, die die Richtung der Extrusion festlegt. Bewegen Sie die Maus nach 
rechts, sehen Sie die neu erschaffenen Vertices.

Möchten Sie stattdessen in eine beliebige Richtung - also schräg - bewegen, müssen Sie zunächst die Festlegung der
Bewegungsrichtung mit einem Klick auf MMT  aufheben. Mit einem weiteren Klick auf MMT  legen Sie die 
Bewegungsrichtung wieder fest. Halten Sie MMT  gedrückt und bewegen die Maus im Kreis, können Sie zwischen
den verschiedenen Achsen wechseln. Um zum ungerichteten Bewegen zurückzukehren muss MMT  nochmal geklickt 
werden. Alternativ kann die X-Taste gedrückt werden, um die Auswahl in X-Richtung zu bewegen. Dasselbe für die
Y-Taste für die Y-Richtung oder die Z-Taste für die Z-Richtung.

Jetzt erschaffen Sie Arme und Beine für Gus.

Bewegen sie die Auswahl mit den neuen Vertices insgesamt 1,5 Kastenlängen nach rechts und klicken sie
LMT , um die Aktion abzuschließen.
Wiederholen Sie die Aktion mit einer halben Kastenlänge wie in Abbildung 7 gezeigt.

Gus hat jetzt einen linken Arm (er schaut Sie an).

Jetzt erschaffen Sie das linke Bein auf demselben Weg, indem sie die beiden 
unteren Vertices auswählen. Versuchen Sie etwas zu erzeugen, was
Abbildung 8 ähnelt.

Ellenbogen und Knie

Wir benutzen das Extrude-Werkzeug drei Mal, um das Bein zu erzeugen. 
Um Ellenbogen haben wir uns nicht gekümmert, aber wir brauchen später

ein Knie, damit Gus laufen kann!

Sich überlagernde Vertices

Wenn Sie extrudieren, und beim Bewegen Esc drücken um die Bewegung
abzubrechen, bleiben die extrudierten Vertices erhalten. Sie nehmen dann

genau die gleiche Position ein wie die Vertices, aus denen sie erzeugt 
wurden. Sie können die neuen Vertices natürlich noch verschieben oder
rotieren, solange Sie ausgewählt sind. Um das Extrudieren vollständig
rückgängig zu machen, wählen Sie zunächst alle Vertices aus, und benutzen
dann Rem Double(s) im Mesh Tools Panel.

Rem Doubles arbeitet nur mit den augewählten Vertices, daher müssen Sie zunächst alle Vertices auswählen,
bevor Sie die Funktion anwenden.

Wenn eine Fläche beim Rendern seltsam aussieht (z.B. grieselig) sollten Sie immer die Möglichkeit in
Betracht ziehen, dass Sie doppelte Vertices in Ihrem Modell haben.

Abbildung 7:  Erzeugen von Gus Arm in 3 Schritten

Abbildung 8:  Der halbe Körper
ist fertig.
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Nun zur anderen Hälfte von Gus:

Klicken Sie auf dem Modifiers Panel in den Editing Buttons auf 
Add Modifier und wählen den Eintrag Mirror  (Abbildung 9).

Gus wird an der X-Achse gespiegelt, so dass Sie nun das 
Ausgangsmesh und das gespiegelte Mesh im 3D-Fenster sehen.
Verändern Sie das Ausgangsmesh, werden alle Änderungen an der
gespiegelten Kopie übernommen. Wenn Sie später näheres zur
Anwendung dieser wichtigen Technik wissen möchten, lesen Sie den
Abschnitt Symmetrisches Modellieren.

Gus benötigt einen Kopf. Auch dieser soll aus einem Würfel entstehen.
Um den Würfel an der richtigen Stelle einzufügen, muss zunächst der
3D Cursor an die richtige Stelle gebracht werden.

Den Cursor positionieren

Um den Cursor an eine bestimmte Stelle auf dem Gitter zu setzen, klicken Sie möglichst nahe an diesen
Punkt (LMT ). Drücken Sie Shift-S, um das Snap-Menü aufzurufen. Die Auswahl Cursor->Grid setzt 

den Cursor auf den Gitternetzpunkt. Cursor->Selection setzt den Cursor auf das ausgewählte Objekt. Die
anderen Einträge bewegen das ausgewählte Objekt.

Bewegen Sie den Cursor, so dass er sich exakt ein Kästchen über dem Körper von Gus befindet (Abbildung 
10, links).
Fügen Sie einen neuen Würfel ein (SPACE>>ADD>>Cube). Das von Space aufgerufene Menü sieht nun
etwas anders aus als vorhin, da wir uns im Edit Mode befinden.
Drücken Sie G, um in den Grab Mode zu wechseln. Bewegen Sie die neu erzeugten Vertices ungefähr ein
drittel Kästchen nach unten, wobei Sie die Bewegungsrichtung mit MMT  einschränken (Abbildung 10, 
rechts).

Gus bekommt nun eine weiche, organische Form. Dazu setzen wir das sogen. Subsurf (Subdivision Surfaces) ein.

Abbildung 9:  Mirror  Modifier hhinzufügen.

Abbildung 10: Einen Kopf hinzufügen
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Klicken Sie im Modifier-Panel auf Add Modifier und wählen Subsurf (Abbildung 11a).
Erhöhen Sie den Wert für Levels auf 2 (Abbildung 11b).
Beenden Sie den Edit Mode (Tab-Taste) und wechseln Sie von der Anzeige des Drahtgittermodells in den 
Solid Mode (Z-Taste).

Jetzt können Sie sich schon eine gute Vorstellung von unserem Modell machen (Abbildung 12, links). Man erkennt 
noch die einzelnen Flächen, aus denen Gus aufgebaut ist.

Um die Übergänge weich verlaufen zu lassen, drücken Sie den SetSmooth Button im Link and Materials-Panel.

Gus hat nun eine glatte Oberfläche (Abbildung 12, rechts).

SubSurfacing

SubSurfacing ist ein fortgeschrittenes Modelling-Werkzeug. Es verfeinert dynamisch ein vorgegebenes 
grobes Netz aus Vertices. Die Form des Objektes ist immer noch durch die äußeren Vertices vorgegeben,

aber gerendert wird das feine Mesh. Benutzen Sie stets möglichst wenig Vertices zur Kontrolle von
SubSurfaces, und stellen sie den SubSurface Level nicht auf 6. Wenn Sie später näheres zur Anwendung
dieser wichtigen Technik wissen möchten, lesen Sie den Abschnitt Subdivision Surfaces.

Mit MMT  und Mausbewegungen können Sie die Blickrichtung verändern und Gus von allen Seiten betrachten. Er ist
nun ein wenig rundlich, und soll abgemagert werden.

Wechseln Sie in die Seitenansicht mit Num-3.

Abbildung 11a: Subsurf Modifier hinzufügen.
Abbildung 11b: SubSurface Einstellungen

Abbildung 12: Gus mit SubSurf Modifier (links) und nach Anwendung von Set Smooth (rechts)
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Wechseln Sie wieder in den Edit Mode (Tab-Taste), wenn Sie sich nicht sowieso darin befinden.
Zurück in die Drahtgitteransicht (Z-Taste).
Wählen Sie alle Vertices mit A aus (Abbildung 13, links).

Wir werden Gus verschlanken:

Drücken Sie S und bewegen die Maus
leicht in horizontaler Richtung (in der 
Richtung, in der Sie skalieren 
wollen). Drücken Sie MMT  oder Y, 
um die Skalierung auf eine Achse
einzuschränken. Wenn Sie die Maus
nun auf Gus zubewegen wird er
dünner, behält aber die gleiche Größe.
In der Werkzeugleiste des 3D Fenster 
wird der Skalierungsfaktor und die 
Achse angezeigt, an der skaliert wird. 
Im 3D Fenster ist die Achse an der 
skaliert wird, farbig markiert (hier in 
gelb).
Drücken und halten Sie Strg. Der 
Skalierungsfaktor ändert sich nun nur
noch in diskreten Schritten von 0.1. 
Skalieren Sie Gus hinunter auf 0.2,
bestätigen Sie die Änderung mit
LMT .
Kehren Sie zur Frontansicht (Num-1) und Solid mode (Z-Taste) zurück, dann schauen Sie ihn sich noch
einmal von allen Seiten an. Er ist viel besser so!

Alternativ hätten wir zur Skalierung auch die 3D Transform Widgets einsetzen können.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1244.html) 

Lasst uns Gus ansehen

Diese Seite bezieht sich auf
Blender v2.42

Wir nähern uns der ersten Bildberechnung (dem sog. Rendering), aber wir müssen noch einige Dinge einstellen.

Der Layer mit der Kamera muss sichtbar gemacht werden, denn Objekte 
werden nur auf sichtbaren Layern gerendert.

Klicken Sie mit Shift-LMT  bei den Layer Buttons den Button rechts 
oben an.

Das macht die Objekte auf Layer 10 sichtbar, das ist in diesem Fall die 
Kamera, die wir dorthin ja verschoben haben.

Aktiver Layer

Der zuletzt ausgewählte Layer ist der aktive, in diesen werden neue Objekte eingefügt. Alle neuen
Objekte werden von nun an also in Layer 10 eingefügt.

Abbildung 13: Gus mit eingeschränkter Skalierung verschlanken

Abbildung 1:  Layer 1 und 10 sichtbar 
machen.
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Wählen Sie die Kamera aus (RMT ) und verschieben Sie sie ungefähr an (x=7, y=-10, z=7). Das Verschieben
wird mit der G-Taste gestartet. Wenn Sie nun die Strg-Taste halten, bewegt sich das Objekt in Schritten von 1
Blendereinheit.

Ort und Rotation festlegen

Sie können numerische Werte für den Ort und die Rotation
eingeben, wenn Sie die N-Taste drücken und im erscheinenden

Panel die entsprechenden Felder ausfüllen (Abbildung 2). Wenn 
das Panel offen ist, können Sie die Position des Objektes immer
kontrollieren, während Sie es mit der Maus verschieben.

Damit die Kamera auf Gus zeigt, lassen Sie die Kamera
ausgewählt (bzw. wählen Sie sie aus) und wählen dann Gus mit
Shift-RMT  aus. Die Kamera sollte Magenta und Gus in Pink 
erscheinen.
Drücken Sie Strg-T und wählen TrackTo Constraint im Popup
Menü.

Damit wird die Kamera gezwungen Gus zu folgen und immer auf ihn zu zeigen. Egal wie die Kamera auch bewegt 
wird, sie wird nun immer auf Gus zeigen.

Tracking

Wenn das folgende Objekt bereits eine Rotation besitzt, wie es z.B. mit der Kamera der Fall ist, zeigt das
Objekt möglicherweise noch nicht in die richtige Richtung. Wählen Sie das folgende Objekt aus (hier die

Kamera) und drücken Alt-R , Clear rotation. Jetzt zeigt die Kamera wirklich auf Gus.

In Abbildung 3 sind Top-, Front-, Seiten- und Kameraansicht gezeigt. Die Kameraansicht erhalten Sie mit Num-0.

Abbildung 2:  Das Transform Properties
Panel
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Jetzt müssen wir den Boden erzeugen, auf dem Gus steht.

In der Ansicht von oben (Num-7) und im Objekt Modus ...
...fügen Sie eine Plane (Ebene) hinzu (Space->Add->Mesh->Plane).

Edit Mode und Object Mode

Es ist wichtig das neue Objekt im Object Mode hinzuzufügen. Sonst wäre das neu erstellt Objekt Teil des
vorherigen Objektes, so wie Gus Kopf. Befindet sich der Cursor an der Stelle wie in Abbildung 3, wäre

die Ebene mitten in Gus Kopf.

Die Ebene befindet sich im Edit Mode, mit Tab wechseln Sie in den Object Mode.
Wechseln Sie zur Frontansicht (Num-1) ...
...und bewegen (G) die Ebene hinunter zu Gus Füßen. Benutzen Sie dabei Strg um die Bewegung nur in festen
Schritten zu gestatten, dann steht Gus direkt auf der Ebene.
Wechseln Sie zur Kameraansicht (Num-0) und skalieren (S) Sie die Ebene, bis die Grenzen der Ebene im 
Kamerabild nicht mehr zu sehen sind.

Die Bildgrenzen werden durch die äußeren schwarzen, gestrichelten Linien in der Kameraansicht angedeutet.

Es werde Licht!

In der Ansicht von oben (Num-7) wählen Sie die vorhandene Lampe aus, und bewegen Sie sie auf die andere
Seite der Kamera, z.B. auf (x=-9, y=-10, z=7).
Mit F5 wechseln Sie auf die Lamp Buttons im Shading Context. 

Im Preview Panel drücken Sie auf Spot um die Lamp Lampe zu einem Spotlicht zu machen. Ändern Sie die

Abbildung 3:  Kameraposition im Verhältnis zu Gus
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Farbe auf ein helles Gelb (R=1, G=1, B=0.9). Klicken Sie Buf. Shadow auf dem Shadow and Spot Panel an. 
Setzen Sie die Werte von ClipSta: auf 5, ClipEnd: auf 50, Samples: auf 4 und Soft: auf 8 (Abbildung 5).
Das Spotlight soll Gus genauso folgen wie die Kamera, daher zunächst die Lampe auswählen (RMT ), dann 
Gus (Shift-RMT ). Strg-T drücken, TrackTo Constraint auswählen. Löschen Sie die Rotation der Lampe,
indem Sie die Lampe allein auswählen und dann Alt-R ->Clear Rotation benutzen.

Fügen Sie eine zweite Lampe an genau dem gleichen Ort wie dem Spot hinzu.

Setzen Sie den Cursor auf den Spot. Dazu wählen Sie die Lampe aus, falls Sie nicht schon sowieso ausgewählt
ist. Drücken Sie Shift-S->Cursor->Selection.
In der Ansicht von oben fügen Sie mit Space->Add->Lamp->Hemi eine Hemi Lampe hinzu. Die Energie der 
Hemi Lampe stellen Sie auf 0.6 (Abbildung 6).

Zwei Lampen?

Eine Lampe genügt praktisch nie, um eine auch nur annähernd vernünftige Beleuchtung zu erzeugen. In
wirklichen Leben kommt das Licht immer von vielen Richtungen, da jeder einzelne Gegenstand zu einer 

Lichtquelle werden kann. Sie erfahren mehr über dieses extrem wichtige Thema im Kapitel Licht.

Beinahe fertig für die erste Bildberechnung.

Wechseln Sie in die Render buttons im Scene Kontext mit F10.
Im Format Panel stellen Sie die Bildgröße auf 640x480, im Render Panel nehmen Sie bitte folgende
Änderungen vor:

Schalten Sie Ray aus, Raytracing benötigt man für Buffer Schatten nicht.
OSA ist das Antialiasing, das ist verhältnismäßig zeitintensiv, führt aber zu deutlich besserer
Bildqualität. Für Testrender können Sie es abstellen.

Haben Sie einen Doppel(kern)prozessor? Dann stellen Sie auf dem Output Panel Threads an, damit auf beiden 
Kernen gerendert wird.

Abbildung 5:  Einstellungen für das Spotlight. Nur ein Teil der Panels für die Lampe ist gezeigt.

Abbildung 6:  Einstellungen für das Hemilight. Nur ein Teil der Panels ist gezeigt.



13 von 31 11.10.2006 21:35

Drücken Sie nun den RENDER Button oder F12.

Das Ergebnis (Abbildung 8) ist noch ziemlich schwach. 
Wir benötigen verschiedene Materialien und viele Details
an der Figur.

Speichern

Wenn Sie es noch nicht getan haben wäre jetzt
der richtige Zeitpunkt die Datei zu speichern. 

Das können Sie über das File->Save Menü tun.
Oder drücken Sie Strg-W. Blender wird Sie 
warnen, wenn Sie eine existierende Datei
überschreiben wollen.

Blender speichert automatisch in das temporäre
Verzeichnis ihres Systems. In der Voreinstellung 
geschieht das alle fünf Minuten. Der Dateiname ist
eine Zahl (z.B. "7659.blend"). Wenn Sie eine automatisch gespeicherte Datei öffnen, können Sie so
unerwünschte Änderungen zurücknehmen.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1473.html) 

Material und Texturen für Gus

Diese Seite bezieht sich auf
Blender v2.42

Jetzt werden wir Gus ein schönes Keks Material verpassen.

Wählen Sie Gus aus.
Wechseln Sie in den Shading Kontext (F5).

Abbildung 7:  Die Render Buttons. Nur ein Teil der Panele ist gezeigt.

Abbildung 8:  Ihr erstes Bild. Glückwunsch!
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Das Buttons Window ist fast leer, da Gus bisher noch keine Materialien
zugewiesen wurden.

Um ein Material hinzuzufügen, klicken Sie auf den Add New
Button im Links And Pipeline Panel (Abbildung 1).

Jetzt erscheinen eine ganze Reihe von Panels und Buttons im Buttons Window.

Die Bezeichnung Material für das Material ändern wir auf "GingerBread". Klicken Sie dazu mit gehaltener
Shift-Taste (Shift-LMT ) in das Feld MA:.
Verändern sie die voreingestellten Werte so wie in Abbildung 2 dargestellt, um ein erstes Rohmaterial zu 
erhalten. Das Bild auf dem Preview Panel dient der Vorschau auf das Material.

Klicken Sie auf Add New im Texture Panel (Abbildung 2 rechts unten). Fügen Sie eine Textur im ersten Kanal
hinzu.
Nennen Sie die Textur "GingerTex" (wieder mit Shift-LMT  ins Feld klicken).

Wechseln Sie in die Texture buttons mit F6, oder klicken Sie auf .
Aus der Auswahlliste der Texture Types wählen Sie Stucci. Setzen Sie alle Parameter wie in Abbildung 3.

Abbildung 1:  Das fast leere Links and 
Pipeline Panel

Abbildung 2:  Das Material buttons Window und ein erstes "GingerBread" Material. Die Panel wurden anders angeordnet, damit sie 
alle auf das Bild passen.
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Kehren Sie zurück in die Material buttons (F5) und klicken Sie auf das Map To Panel.
Stellen Sie Col aus und Nor an. Den Nor Schieberegler stellen Sie auf 0.75 (Abbildung 4).

Dadurch wird die Stucci Textur zu einer sogenannten Bumpmap. Es sieht dann so aus, als hätte die Oberfläche von
Gus Erhöhungen und Vertiefungen - eben so, wie ein Keks aussehen sollte.

Jetzt fügen wir eine zweite Textur hinzu.

Klicken Sie auf den zweiten Texturkanal (einer von den leeren Buttons auf dem Texture Panel). Klicken Sie 
auf Add New.
Nennen Sie diese neue Textur "Grain". Diese Textur soll nur den Ref Parameter beeinflussen. Den Blending 
Mode auf Add stellen und Var auf 0.4. Als Textur Typ wählen Sie Noise. In Abbildung 5 habe ich die 
relevanten Panel zusammengestellt. Ref beeinflusst die Helligkeit des Materials.

Abbildung 3:  Die Texture buttons mit einer Stucci Textur.

Abbildung 4:  Die Textureinstellungen in den Material buttons für die Stucci Textur.

Abbildung 5:  Einstellungen für die Ref Map. Links die Materialeinstellungen, rechts die Textur selbst.
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Der Fußboden bekommt ein
einfaches, dunkelblaues Material 
nach den Einstellungen aus 
Abbildung 6. Wählen Sie dazu
den Fußboden aus und fügen Sie
wie oben ein neues Material
hinzu. Ändern Sie die
Einstellungen entsprechend.

Es ist jetzt eine gute Gelegenheit ihre 
Datei zu speichern. Rendern Sie ein Bild
und schauen Sie sich die verschiedenen 
Materialien an. Beobachten Sie die 
Wirkung der verschiedenen Texturen. Der Haken vor dem Texturnamen (Abbildung 5, ganz links) kann eine Textur
temporär deaktivieren.

Und wo sind die Augen und Drops Knöpfe? Die fügen wir nun hinzu.

Augen

Schalten Sie in die Wireframe Ansicht (Z). Schalten Sie den 3D Transform Manipulator aus 
(Strg-Space->Enable/Disable). Platzieren Sie den 3D-Cursor ungefähr in die Mitte von Gus Kopf. Sie
befinden sich in einem 3D-Programm, also müssen Sie den Cursor in mindestens zwei Ansichten platzieren.
Achten Sie darauf, dass Sie sich im Object Mode befinden.
Fügen Sie eine Kugel hinzu (Space->Add->Mesh->UVSphere). Sie werden nach der Anzahl der Segments:
und Rings: gefragt, die die Detailliertheit der Kugel angeben. Die voreingestellten 32 sind viel zu viel, 16 
werden mehr als ausreichen.
Skalieren Sie die Kugel klein (S-Taste, Strg beim Skalieren drücken) auf einen Faktor von 0.1 in allen drei
Raumrichtungen. Dann wechseln Sie in die Seitenansicht (Num-3) und skalieren nur noch in horziontaler 
Richtung (S-Y-Tasten, Strg beim Skalieren drücken) um den Faktor 0.5.
Zoomen Sie ein bißchen in die Szene hinein (Num-+ oder MR  oder Strg-MMT ).
Bewegen Sie die Kugel (G) nach links, so dass sie halb aus dem Kopf herausschaut. Wenn Sie die Bewegung 
anfangen, und dann mit der mittleren Maustaste klicken, schränken Sie die Bewegung auf eine Richtung ein.
Zurück in der Vorderansicht (Num-1) bewegen (G) Sie die Kugel zur rechten Seite an die Stelle, wo Gus Auge
sitzen soll.

Nun werden wir das Auge kopieren und spiegelbildlich im Gesicht von Gus platzieren. Für den Körper hatten wir
einen Mirror Modifier  benutzt, damit Sie auch noch eine andere Methode kennenlernen, werden Sie das Auge "von 
Hand" kopieren.

Die Vertices des linken "Auges" sind ja noch ausgewählt. Wählen Sie
den Eintrag 3D Cursor im Pivot-Menü des Headers des 3D-Fensters
(Abbildung 7). Der 3D-Cursor sollte sich bei Ihnen an der gleichen 
Stelle befinden wie auf der Abbildung 8, unten Mitte!
Drücken Sie Shift-D, um alle ausgewählten Vertices, Edges und Faces
zu kopieren. Die neu erzeugten Objekte befinden sich im 
Bewegungsmodus (Grab Mode), drücken Sie Esc, um diesen Modus zu
beenden, ohne die Vertices tatsächlich zu bewegen.
Drücken Sie Strg-M , um das Mirror Axis-Menü (Achsenspiegelung)
zu öffnen. Wählen Sie X Global. Gus sollte jetzt so aussehen wie in 
Abbildung 8, unten rechts.

Reference center (Bezugspunkt)

Skalieren, Rotieren und andere Mesh Änderungen beziehen sich
immer auf einen bestimmten Bezugspunkt. Das kann die Cursorposition, das Zentrum des Objektes, das 

Schwerezentrum des Objektes, das Zentrum der Bounding Box, das Schwerezentrum mehrerer ausgewählter
Objekte oder das zuletzt ausgewählte Objekt sein (Abbildung 7). Der Button der so aussieht wie ein 
Fadenkreuz, wählt den Cursor als Bezugspunkt aus.

Abbildung 6:  Ein einfaches Material für den Fußboden.

Abbildung 7:  Angriffspunkt für
Rotation und Skalierung auf den 
3D-Cursor setzen (Pivot-Menü)
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Teile des Meshes als eigenes Objekt abtrennen

Wenn Sie sich doch mal mit dem Edit- und dem Object Modus beim Hinzufügen eines Mesh-Objektes
vertun, kein Problem. Wählen Sie die gewünschten Vertices aus und drücken P für Separate. Dann wird 

ein neues Objekt aus diesen Vertices erstellt. Besitzt das alte Objekt allerdings bereits ein Material, so trägt
das separierte Objekt dieses Material ebenfalls. Am einfachsten löschen Sie zunächst das Material von Ihrem
neuen Objekt. Dazu klicken Sie im Links and Pipeline Panel auf das "x" neben dem Materialnamen.

Mund

Gehen Sie in den Object Modus (Tab) und platzieren Sie den 
Cursor so nahe wie möglich im Zentrum von Gus Gesicht. Fügen
Sie eine neue Kugel hinzu und skalieren und bewegen Sie sie 
genauso wie vorhin das Auge. Bewegen Sie sie an die Stelle, an der 
Gus Mund anfangen soll (Abbildung 10, Mitte).
In den Editing Buttons (F9) befinden sich die Buttons zur Steuerung
des Spin Werkzeuges. Stellen Sie Degr: auf 90, Steps: auf 3 und
überzeugen Sie sich, dass der Button Clockwise gedrückt ist.
Nachdem Sie alle Vertices markiert haben drücken Sie SpinDup
(Abbildung 9). Ein kleines Fragezeichen erscheint am Mauscursor. 
Klicken Sie mit LMT in die Vorderansicht. Das erzeugt drei Kopien 
auf einem 90 Grad Bogen, dessen Zentrum am Cursor liegt. Das 
Ergebnis sollte so aussehen wie das rechte Bild in Abbildung 10.

Abbildung 8:  Sequenz zum Erzeugen von Gus Augen

Abbildung 9:  SpinDup Werkzeug
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Die Knopfleiste

Sie sind jetzt vermutlich in der Lage, drei weitere von diesen 
Ellipsoiden anzufertigen, die Gus Knöpfe darstellen sollen.

Erzeugen Sie zuerst einen Knopf, beenden dann den 
Edit Modus mit Tab (nicht im Editmode kopieren!),
drücken Shift-D um Kopien anzufertigen, und 
verschieben die Knöpfe wie in Abbildung 11 gezeigt.

Das übrige Material

Augen, Mund und Knöpfe bekommen jetzt jeweils ein Material, die Einstellungen sind in Abbildung 13 zu sehen. Die
Augen werden "schokoladig", der Mund soll aus weißem Zucker bestehen. Die Knöpfe sollen Rot, Weiß und Grün
werden. Da der Mund und der mittlere Knopf aus weißem Zucker bestehen sollen, sollen Sie natürlich das gleiche
Material erhalten.

Die Materialien sind sehr ähnlich. Daher benutzen wir ein Material, und "kopieren" dieses Material auf das nächste
Objekt. Dieses Kopieren funktioniert in Blender etwas anders, als Sie es vermutlich gewohnt sind.

Wählen Sie die Augen aus und erstellen Sie das Material Choccolate mit den Einstellungen aus Abbildung 13, 
oben.
Wählen Sie nun den Mund aus. Der Mund trägt noch kein Material.
Klicken Sie auf dem Links and Pipeline Panel auf den Doppelpfeil neben dem Add New Button.
Wählen Sie das Material Choccolate aus.

Abbildung 10: Gus Mund wird mit SpinDup erzeugt.

Abbildung 11: Gus Modell ist fertig.
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Wie Sie nun auf dem Links and Pipeline Panel sehen können, hat das
Material zwei Benutzer (Abbildung 12). Das Material ist also nicht kopiert 
worden, sondern mit zwei Objekten verlinkt. Ändern wir jetzt das
Material, würde es sich auf allen verlinkten Objekten ändern. Das ist in
diesem Fall unerwünscht, daher muss aus dem verlinkten Material eine
echte Kopie gemacht werden (ein sog. Single User).

Klicken Sie auf die kleine "2" neben dem Materialnamen, und
bestätigen Sie Single user.

Das Material heist jetzt Choccolate.001.

Bennen Sie das Material in White Sugar um, und ändern Sie die entsprechenden Einstellungen wie in
Abbildung 13.

Verlinken statt Kopieren

Diese Vorgehensweise zum Kopieren von Objekten ist typisch in Blender. Zunächst wird etwas verlinkt,
also an mehreren Stellen benutzt. Das ist sehr praktisch, spart es doch überflüssigen Speicherplatz und

ermöglicht die nachträgliche Veränderung von vielen Objekten auf einmal. Benötigen Sie dann eine

Abbildung 12: Das Material hat zwei 
Benutzer.

Abbildung 13: Einige weitere Materialien für Gus, oben "Schokolade", darunter der "Zucker" in drei verschiedenen Farben.
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eigenständige Kopie, wird die Verlinkung aufgehoben, und durch eine echte Kopie ersetzt. Dieser Vorgang
heisst in Blender "Make Single User". Auf diese Weise lassen sich viele Objekte mit dem gleichen Material 
versehen, 3D Objekte können in vielen Szenen gleichzeitig benutzt werden, lassen sich aber trotzdem noch
nachträglich ändern usw.

Wie oben beschrieben, erzeugen Sie weitere Materialien:

Der oberste Knopf erhält das Material Red Sugar.
Der unterste Knopf erhält das Material Green Sugar.
Wählen Sie für den mittleren Knopf das Material White Sugar aus der Menüliste aus.

Dieses Material soll noch die Grain Textur von dem Keks-Material erhalten. Bei den Texturen kann man ebenfalls 
vorhandene Texturen durch Menüauswahl einem Kanal zuweisen, aber die Textur hat ja auch noch
Materialeinstellungen. Diese Materialeinstellungen müssen ebenfalls übertragen werden. Diesen Vorgang werde ich
schrittweise beschreiben:

Wählen Sie den Körper von Gus aus (RMT ).1.
Wählen Sie im Texture Panel die Grain Textur aus (LMT ).2.

Klicken Sie (LMT ) auf den Copy To Buffer Button (Pfeil nach oben auf dem Texture Panel) .3.
Wählen Sie den Mund aus (RMT ).4.
Wählen Sie den ersten Texturkanal aus.5.
Klicken Sie (LMT ) auf den Copy From Buffer Button (Pfeil nach unten).6.

Das Material White Sugar sollte dann insgesamt so aussehen wie in Abbildung 14.

Nachdem wir alle Materialien erzeugt und zugewiesen 
haben, sollten wir mal wieder ein Bild rendern. Das 
Ergebnis sollte so ähnlich aussehen wie in Abbildung 15.

Wenn Sie wollen, können Sie ihr Bild nun speichern.
Drücken Sie dazu bei offenem Render-Fenster F3. 
Benennen Sie die Datei inklusive Dateiendung - also z.B. 
.jpg oder .png - und klicken auf Save XXX, wobei XXX 
das Dateiformat angibt.

Dateitypen und Endung

In den Render buttons (F10) im Format Panel 
stellen Sie das gewünschte Dateiformat ein. Die

Dateiendung im Save Dialog sollten Sie natürlich
dazu passend wählen. Blender ergänzt eine
fehlende Dateiendung nicht (das ist ja auch nicht 
bei allen Betriebssystemen nötig).

Die erste Hälfte dieser Einführung ist nun beendet, unsere Figur ist fertig. In der nächsten Hälfte der Einführung

Abbildung 14: White Sugar. Achten Sie insbesondere auf die Zahlen neben dem Materialnamen und neben der Textur. Zwei 
Objekte tragen das Material, zwei Materialien benutzen die Textur. Aber drei Objekte tragen die Textur!

Abbildung 15: Gus mit Material
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bringen wir Gus das Laufen bei.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1632.html) 

Rigging

Diese Seite bezieht sich auf
Blender v2.42

Wollten wir nur ein Bild rendern wären wir schon fertig, aber Gus soll sich bewegen. Im nächsten Schritt werden wir
ihm ein Skelett geben, eine sogenannte Armature. Bewegt man die Armature bewegt sich auch die Figur. Das
Ausrüsten einer Figur mit einer Armature wird auch Rigging genannt.

Gus erhält ein einfaches Rigging: vier Extremitäten (zwei Arme und zwei Beine) und einige Gelenke (keine
Ellenbogen, nur Knie). Auf Hände und Füße verzichten wir.

Den Mirror  Modifier mit dem wir Gus` Körper erstellt haben, müssen wir
jetzt permanent anwenden, schließlich soll Gus ja nicht immer gleichzeitig
beide Arme und Beine heben.

Wählen Sie Gus aus.
Wechseln Sie mit F9 in die Editing Buttons.
Klicken Sie auf dem Modifiers Panel für den Mirror  Modifier auf 
Apply (Abbildung 1) und bestätigen Sie die Nachfrage.

Jetzt können wir beginnen, das Skelett zu erstellen.

Schalten Sie in den Wireframe Modus.
Setzen Sie den 3D-Cursor an die Stelle, an der sich 
die Schulter befinden soll. Denken Sie daran, dass 
sie den Cursor in zwei Ansichten platzieren müssen.
Space->Add->Armature.

Das rhomboide Objekt, das erscheint, ist ein Knochen 
[Bone] des Armature Systems. Es beginnt am 3D-Cursor. 
Die Spitze [Tip] des Knochens ist ausgewählt und erscheint
in Gelb.

Mit G können Sie die Spitze des Knochens nun
bewegen, mit LMT  platzieren Sie die Spitze an der 
Stelle, an der sich Gus Hand befindet.

Abbildung 1:  Den Mirror  Modifier auf 
Gus permanent anwenden.

Abbildung 2:  Gus erster Knochen
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Bleiben Sie im Edit Modus der Armature.

Bewegen den 3D-Cursor an die Stelle, an der sich Gus
Hüfte befinden soll.
Space->Add->Bone, der neue Bone soll bis zum Knie 
reichen. Mit G die Spitze bewegen, mit LMT  platzieren.

Wir wollen nun einen zweiten Bone an den
Oberschenkelknochen anhängen, dazu benutzen wir das
Extrudieren.

Drücken Sie also E und platzieren Sie den dritten Knochen 
wie in Abbildung 3 gezeigt vom Knie bis zum Fuß.

Bone Position

Die Bones sollen später Gus Körper Mesh verformen. Dazu muss die Positionierung der Bones so
erfolgen, dass z.B. der Arm Bone den ganzen Arm, und nur den Arm bewegen kann.

Die erstellten Bones werden nun benannt:

Klicken Sie im Armature Panel auf Draw Names.
Nennen Sie den Arm-Bone "Arm.L", den oberen Bone des Beines "UpLeg.L", den unteren Bone des Beines 
"LoLeg.L" (Abbildung 4 zeigt das Endergebnis nach dem nächsten Schritt).

Die linke Seite der Bones wird - genau wie wir es bei den Augen gemacht haben - nun kopiert und gespiegelt.

Platzieren Sie den 3D-Cursor im Zentrum von Gus.
Wählen Sie mit A-A alle Bones aus.
Kopieren und spiegeln Sie mit Shift-D, Esc, M ->X Global.

Die Bones der rechten Seite sind ausgewählt. Ist das nicht der Fall, müssten Sie sie separat auswählen. In den Editing
Buttons (F9) werden im Panel Armature Bones die ausgewählten Bones aufgeführt. Die Namen der Bones der rechten
Seite müssen noch geändert werden.

Nennen Sie sie Arm.R, UpLeg.R und LoLeg.R (Abbildung 4).
Beenden Sie nun den Edit Modus für die Armature (Tab).

Abbildung 3:  Den zweiten und dritten Bone hinzufügen
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Bones benennen

Das angehängte .L bzw. .R sind sehr wichtig. Dann kann uns nämlich der Computer helfen, eine
seitenverkehrte Pose automatisch zu erstellen. Sonst müssten wir alle Posen von Hand zweimal

einstellen.

Ich kann im Armature Bones Panel nicht alle Bones sehen

Es werden in diesem Panel nur immer maximal 5 der ausgewählten Bones angezeigt. Sie müssen dann
immer die entsprechenden anderen Bones auswählen. Da Sie aber Bones durch ein eigenes Layersystem

nur für die Bones in Gruppen anzeigen lassen können, dürfte dies keine Einschränkung darstellen.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1829.html) 

Skinning

Diese Seite bezieht sich auf
Blender v2.42a

Würden wir die Bones jetzt bewegen, würde sich Gus noch nicht mitbewegen. Wir müssen die Armature mit dem
Körper verbinden. Diesen Vorgang nennt man Skinning. Dabei werden Vertices den Knochen zugewiesen, so dass 
sich diese mit den Knochen mitbewegen.

Abbildung 4:  Editing Buttons für eine Armature
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Setzen Sie den Pivot-Punkt auf Median.

Die Bones werden später rotiert, dabei sollen sie um sich selbst rotieren. Deshalb
muss der Pivot-Punkt wieder auf Median zurückgesetzt werden.

Wählen Sie Gus` Körper aus, dann Shift->RMT  auf die Armature.

Der Körper sollte magenta und die Armature pink erscheinen.

Strg-P macht die Armature zum 
Parent [Elternteil] des Körpers. Es
erscheint eine Dialogbox 
(Abbildung 2).
Wählen Sie Armature aus.

Es erscheint ein weiteres
Menü. Man könnte versuchen
die Zuordnung 
"Vertices->Bone" vom 
Programm automatisch 
erledigen zu lassen. Das 
funktioniert in unserem Fall 
nicht gut, und wir müssten
diese automatische Zuordnung 
erst wieder löschen. Daher lassen wir keine Vertexgruppen erstellen.

Wählen Sie also Don't Create Groups aus (Abbildung 3).

Aus dem Armature Parent muss nun ein echter Modifier erstellt werden.

Wählen Sie Gus aus.
Klicken Sie auf dem Modifiers Panel neben Armature Parent Deform auf 
Make Real (Abbildung 4).

Es gibt zwei 
verschiedene 
Mechanismen, wie ein 
Bone einen Vertex 
beeinflussen kann, 
Vertexgruppen und 
Envelopes.

Die Envelopes schalten Sie bitte auf dem Modifiers Panel aus
(Abbildung 5).

Im nächsten Schritt muss ausgewählt werden, welche Teile des Meshes von welchem Bone bewegt werden. Dazu
müssen Vertexgruppen erstellt werden. Blender bietet hierzu eine intuitive Technik an, die Weight Painting [Einfluss 
aufmalen] genannt wird, da mit einer Art Pinsel die Einflussstärke - in diesem Fall eines Bones - auf das Mesh
aufgemalt wird wie eine Farbe. Gleichzeitig werden die entsprechenden Vertexgruppen von Blender automatisch 
erstellt. Um die Vertexgruppen brauchen Sie sich also - bei Benutzung des Weight Painting - nicht zu kümmern.

Skinning mit Weight Painting

Abbildung 1:  Pivot Point
Median.

Abbildung 2:  Armature und Objekt "parenten"

Abbildung 3:  Keine Vertexgruppen 
erstellen

Abbildung 4:  Umwandeln des Armature
Parent in einen echten Modifier.

Abbildung 5:  Envelopes ausschalten.
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Wählen Sie die Armature aus.
Wechseln Sie in den Pose Modus der Armature (Abbildung 6).

Der Pose Modus ist ein spezieller Bearbeitungsmodus, den nur Armatures besitzen.

Schalten Sie auf dem Armature Panel die Option X-Ray für die Armature an.

Dann ist die Armature immer sichtbar, auch wenn andere Objekte nicht im Wireframe 
Modus dargestellt werden.

Wählen Sie Gus aus. Schalten Sie für Gus den Weight Paint Modus an (Abbildung
7).
Wählen Sie mit RMT  den Bone Arm.L aus.

Ihre Szene sollte etwa so aussehen, wie in Abbildung 8
dargestellt. Um den Einfluss des Bones zu sehen, drücken
Sie R, und rotieren den Bone etwas. Es sollte sich kein Teil 
des Meshes mitbewegen. Brechen Sie die Bewegung mit Esc
ab.

Die relative Einflussstärke des ausgewählten Bones auf
einen Vertex wird durch die Farbe des Vertex symbolisiert. 
Blau bedeutet dabei kein Einfluss (0%), Grün bedeutet 50%
Einfluss und Rot 100% Einfluss. Vertices die nur von einem 
Bone beeinflusst werden, werden dabei immer vollständig
bewegt, egal ob der Weight  "1" oder "0.001" beträgt. Erst
wenn ein zweiter Bone den Vertex beeinflusst, werden die 
Weights miteinander verrechnet.

Nur wenn der Weight "0.000" beträgt, bewegt der Bone den
Vertex nicht.

Für Gus mit seinem einfachen Rig bedeutet das, dass wir
entweder mit "0.000" malen werden um Vertices aus dem 
Einflussbereich des Bones zu entfernen, oder mit "1.000" um
Vertices zu dem Einflussbereich des Bones hinzuzufügen.

Abbildung 6:  Pose
Modus für die

Armature anstellen.

Abbildung 7:  Weight 
Paint Modus für Gus

anschalten.

Abbildung 8:  Der Bone des linken Armes ist
ausgewählt.
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In den Editing Buttons von Gus ist ein neues Panel aufgetaucht, als wir 
in den Weight Paint Modus geschaltet haben, das Paint Panel 
(Abbildung 9).

Stellen Sie die Parameter so ein, wie in Abbildung 9 gezeigt.
Dabei ist Weight das Gewicht - also 1 für vollen Einfluss
des Bones, 0 für keinen Einfluss.
Die Opacity ist die Deckkraft des Pinsels.
Den Parameter Soft schalten Sie am besten aus, da sonst 
der Wert "0.000" nur schwer aufzumalen ist.
Ist X-Mirror  aktiviert, werden automatisch auf beiden 
Seiten des Meshes die Vertexgruppen erstellt und den 
entsprechenden Bones zugeordnet. Die Bones heißen ja
"Arm.L" und "Arm.R", dementsprechend werden beim 
Bemalen von "Arm.L" die Vertices ebenfalls für "Arm.R"
bemalt.

Malen Sie die Spitze des Arms rot an 
(LMT  gedrückt halten).

Da der Bone Arm.L aktiv ist, erstellt Blender die 
Vertexgruppe Arm.L und weist die angemalten 
Vertices der Gruppe zu. Dank X-Mirror  geschieht 
das gleiche (für uns allerdings unsichtbar) mit
Arm.R.

Sie müssen Gus von vorne und von hinten
bemalen, die Ansicht im 3D Fenster also 
zwischendurch drehen - entweder mit 
gehaltener mittlerer Maustaste oder mit 
Strg-Num1.
Wählen Sie nun einen der beiden "UpLeg"
Bones aus, und bemalen das Knie.
Wählen Sie nun einen der beiden "LoLeg"
Bones aus, und bemalen den Fuß.

Rotieren Sie die Bones zwischendurch etwas, aber 
brechen Sie die Bewegung immer mit Esc ab. So
können Sie gut kontrollieren, ob der
Einflussbereich des jeweiligen Bone passt.

In Abbildung 10 ist dargestellt, wie Gus hinterher 
aussehen sollte. Sie sehen dort die Weights von 
drei Bones gleichzeitig, so bekommt man Sie in Blender nicht direkt zu sehen. Die roten Einflussbereiche der Bones 
gelten jeweils für den benachbarten Bone.

Haben Sie sich vermalt, stellen Sie den Weight auf 0 und bemalen mit Blau.

Wenn Sie mit dem Ergebnis zufrieden sind, schalten Sie vom Weight Paint in den Objekt Modus.

Ein Tip zum Schluss

Andere Details

Die Verformungen betreffen nur Gus Körper, weder seine Augen, Mund oder Knöpfe, die separate

Abbildung 9:  Das Paint Panel für Gus.

Abbildung 10: Die Weigths für drei Bones gleichzeitig.
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Objekte sind. In dieser einfachen Animation spielt das keine Rolle, aber bei komplexeren Objekten müssen
Sie überlegen, wie sie mit diesen Objekten verfahren wollen. Sie können Sie z.B. fest mit dem Körper
verbinden (joinen) und ein einzelnes Mesh daraus machen. Oder Sie parenten die Objekte an den Körper, so
dass sie sich mit ihm mitbewegen. (Das wird alles in den weiteren Kapiteln beschrieben.)

Jetzt ist wieder der richtige Zeitpunkt, Ihre Arbeit zu speichern. Drücken Sie F2, Num-+, Enter.

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1884.html) 

Posing

Diese Seite bezieht sich auf
Blender v2.42

Nachdem wir Gus jetzt geriggt und geskinnt haben, können wir anfangen mit ihm wie mit einer Puppe zu spielen,
seine Knochen bewegen und die Ergebnisse beobachten.

Wählen Sie die Armature aus (nur die Armature), und stellen Sie sicher, dass sich die Armature im Pose
Modus befindet.

Um die Auswirkungen der Bewegungen besser beurteilen zu
können, schalten wir mit Z wieder in den Shaded Modus.

Durch die Option X-Ray auf dem Armatures Panel (Abbildung 1) 
werden die Bones immer vor dem Objekt dargestellt, auch wenn sie sich
in oder hinter einem Objekt befinden.

Da sich die Armature im Pose Modus befindet, wird ein ausgewählter
Bone Zyan dargestellt.

Ausgangsposition

Blender merkt sich die Ausgangsposition der Bones. Sie
können die Ausgangsposition der Armature sehen, indem Sie

auf Rest Position im Armature Panel in den Editing Buttons 
klicken. Mit Alt-R  bzw. Alt-G  setzen Sie die Rotation bzw. die Position des Bones zurück.

Vorwärts- und Inverse Kinematik

Bones im Pose Modus verhalten sich wie starre, nicht dehnbare Knochen mit Kugelgelenken am Ende. 
Man kann das erste Bone in einer Kette bewegen, und alle weiteren Bones werden ihm folgen. Die 

folgenden Bones können nicht verschoben werden, Sie können sie nur rotieren. Die Kette der folgenden
Bones folgt dann der Drehung. Diese Methode der Bewegung wird "Forward Kinematics" (FK) genannt, und
ist leicht zu verstehen. Es ist allerdings schwierig den letzen Bone der Kette in eine bestimmte Position zu 
brigen. Das ist mit der "Inverse Kinematic" (IK) anders. Die Position des letzten Bones in der Kette wird 
festgelegt, alle anderen Bones folgen dann automatisch hinterher. Damit wird die Positionierung von Händen
und Füßen viel einfacher.

Da wir hier aber ein Anfängertutorial machen, benutzen wir Vorwärts Kinematik

Wir werden Gus vier verschiedene Posen beibringen. Diese definieren vier verschiedene Stadien eines Schrittes. Die
flüssige Überblendung zwischen diesen Posen übernimmt Blender für uns.

Abbildung 1:  X-Ray stellt die Bones immer 
vor dem Objekt dar.
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Stellen Sie zunächst sicher, dass Sie sich im
Frame 1 befinden. Die Framenummer erscheint 
in einem Zahlenfeld rechts im Header des 
Buttons Window (Abbildung 2). Ist nicht Frame 
1 eingestellt, ändern Sie dies bitte jetzt.

Rotieren (R) Sie immer nur einen Bone gleichzeitig.

Heben Sie UpLeg.L an und beugen Sie LoLeg.L, außerdem heben Sie Arm.R und senken Arm.L, wie in 
Abbildung 3 gezeigt wird.

Wählen Sie alle Bones mit A, bzw. A-A  aus.
Stellen Sie sicher, dass sich der Mauszeiger über dem 3D-Fenster befindet.
Drücken Sie I .

Das InsertKey Menü erscheint (Abbildung 4). Sie speichern nun einen sogenannten IPO 
(Interpolation) Key.

Wählen Sie LocRot aus. Damit wird die Position und die Rotation der ausgewählten
Bones in Frame 1 gespeichert. Diese Pose zeigt Gus in der Mitte des Schrittes, linkes Bein
nach vorne und über der Erde.

Wechseln Sie zu Frame 11. Das geht entweder über die Eingabe im Zahlenfeld, oder
drücken Sie Pfeil Hoch.
Bewegen Sie Gus in seine zweite Position (Abbildung 5). Das linke Bein nach vorne und 
das rechte Bein leicht nach hinten gebogen.

Sie merken schon, Gus soll sich auf der Stelle bewegen.

Erst den Frame wechseln, dann die Position

Gewöhnen Sie sich unbedingt an diese Reihenfolge in einer Animation. Wechseln Sie erst den Frame,
dann definieren Sie die Position. Würden Sie andersherum vorgehen, geht beim Wechseln des Frames

die Position wieder verloren.

Abbildung 2:  Die Nummer des aktuellen Frames im Frame 
number button im Header des Buttons Window

Abbildung 3:  Die erste Pose

Abbildung 4:
Das Insert Key

Menü
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Wählen Sie alle Bones aus und drücken I ->LocRot um die Pose in Frame 11 zu speichern.

Die dritte Pose ist das Spiegelbild von Frame 1. Die spiegelbildliche 
Pose kann Blender automatisch erstellen, da wir die Bones richtig 
benannt haben. Wir müssen zunächst die erste Pose kopieren.

Wechseln Sie in Frame 1 (Pfeil Runter). Im Pose Menü wählen Sie

Copy Current Pose aus (Abbildung 6), oder klicken Sie auf  im 
Header des 3D-Fensters (Copies the current Pose to Buffer).

Wechseln Sie in Frame 21.
Fügen die spiegelbildliche Pose mit dem Pose Menü ein (Paste Flipped 

Pose), oder benützen Sie den Button .

Die Position der Bones mit dem Suffix ".L" wird von Blender mit der 
Position der Bones mit dem Suffix ".R" vertauscht. Dadurch entsteht die 
spiegelbildliche Pose.

Nun muss die Pose wieder gespeichert werden (I ->LocRot).
Wiederholen Sie diese Prozedur um die Pose von Frame 11 gespiegelt in
Frame 31 einzufügen.

Wir sind fast fertig, müssen aber die Ausgangspose von Frame 1 ganz
am Ende noch einmal wieder einfügen, um eine nahtlose und flüssige
Animation zu erzeugen.

Kopieren Sie die Pose aus Frame 1 und fügen Sie sie in Frame 41 ein, diesmal ohne sie zu spiegeln (Paste 
Pose im Pose Menü).
Auch diese letzte Pose müssen Sie wieder mit I ->LocRot speichern.

Überprüfen der Animation

Für eine Voransicht der Animation im 3D-Fenster wechseln Sie in Frame 1 und drücken Alt-A  im 
3D-Fenster. Mit Alt-Shift-A  wird die Animation in allen offenen 3D-Fenster abgespielt.

Abbildung 5:  Die zweite Pose wird in Frame 11 gespeichert.

Abbildung 6:  Die Pose aus Frame 1 in den 
Speicher kopieren.
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Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x1960.html) 

Gus läuft!

Diese Seite bezieht sich auf
Blender v2.42

Dieser eine "Schritt auf der Stelle" ist der Kern des Gehens, und wenn er erst einmal definiert ist, gibt es Techniken 
um die Figur entlang eines Pfades gehen zu lassen (Stride Path). Wir werden an dieser Stelle aber unsere kurze
Einführung beenden, der "Schritt auf der Stelle" ist hier genug.

Die Grain-Textur taugt leider nicht zum Animieren.

Wechseln Sie aus dem Pose Modus in den Object Modus der Armature.
Wählen Sie Gus` Körper aus und wechseln Sie in den Shading Kontext (F5). Entfernen Sie in den Material 
Buttons auf dem Texture Panel den Haken vor der Grain Textur.

Wechseln Sie in die Render Buttons (F10).
Stellen Sie im Animation Panel Sta auf 1 und End auf 40 (Abbildung 1). Frame 41 müssen wir nicht rendern,
da er mit Frame 1 identisch ist.

Wählen Sie AVI Raw als Dateityp im Format Panel.

Normalerweise ist das nicht die beste Wahl, da das sehr große Dateien produziert. Es ist aber schnell und läuft auf
jeden Fall auf jedem PC. AVI Jpeg ist deutlich kleiner, benutzt aber die verlustbehaftete Jpeg-Kompression. Am
besten für die praktische Arbeit ist allerdings die Erzeugung von Einzelbildern (TGA oder Jpeg), die hinterher in
einem Videoschnitt-Programm zu einem Video zusammengefügt werden.

Im Panel Output schreiben Sie in das oberste Feld den Eintrag "//render/".

Die startenden beiden Slashes und der endende Slash sind wichtig. Damit wird das - eventuell automatisch zu 
erstellende - Unterverzeichnis "render" des aktuellen Verzeichnisses bezeichnet.

Nun klicken Sie auf ANIM im Anim-Panel.

Alle Layer, die tatsächlich auch gerendert werden sollen, müssen in den Layerbuttons ausgewählt sein. In unserem
Fall sind das Layer 1 und 10, aber wenn Sie der Einleitung exakt gefolgt sind, sollte alles in Ordnung gehen.

Ein Rendering stoppen

Wollen Sie ein Rendering zwischendurch stoppen, weil Sie z.B. einen Layer vergessen haben, können
Sie das Rendern mit Esc anhalten. Wenn Sie ein "AVI" rendern, verlieren Sie allerdings die bisher 

gerenderten Bilder. Einzelbilder bleiben erhalten, so dass Sie abschnittsweise rendern können.

Abbildung 1:  Die Render Einstellungen für Gus Animation
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Unsere Szene ist ziemlich einfach, daher wird jedes Einzelbild vermutlich in wenigen Sekunden gerendert. Sie
können Blender beim Rendern zuschauen. Haben Sie einen Rechner mit Dualprozessor, aktivieren Sie den Button
Threads, der stellt die Unterstützung für Dualprozessoren an. Die Renderzeit wird in dieser Szene im wesentlichen
von dem Antialiasing bestimmt. Den Antialiasing Wert stellen Sie mit OSA (Oversampling) ein.

Die Bildgröße können Sie für schnelle Testrenderings über die Prozent-Buttons im Render Panel bequem reduzieren.

Stills (Standbilder)

Natürlich können Sie jeden einzelnen Frame der Animation rendern, wenn Sie in den entsprechenden
Frame wechseln und F12 drücken.

Nachdem alle Bilder gerendert wurden, befindet sich die Datei 0001_0040.avi im Unterverzeichnis "render" des 
aktuellen Verzeichnisses, indem sich ihre .blend Datei befindet. Sie können diese Datei direkt in Blender abspielen,
wenn Sie den Play Button unterhalb des Anim Buttons drücken. Die Animation läuft in einer Endlosschleife. Um sie
anzuhalten, drücken Sie Esc.

Unser einfacher "Walk Cycle" ist fertig. Ich hoffe, Ihnen hat das Spaß gemacht. Blenders Möglichkeiten haben wir
nur oberflächlich angekratzt, wie Sie vermutlich bald entdecken werden!

Links

Die englischsprachige Vorlage dieses Textes (http://www.blender.org/modules/documentation/htmlI/x2058.html) 

Von „http://de.wikibooks.org/wiki/Blender_Dokumentation/_Druckversion/_Gus“
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